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Preface 

About This Tutorial 

The Automated Workflow Management Tutorial introduces the Falcon32 workflow 
management system, allowing supervisors to organize the flow of data and distribute it to 
pre-specific operators by completing and assigning waybill work orders. 

Chapter 1 Introduction defines the waybill workflow management system. 

Chapter 2 Supervisor Functions explains how supervisors can create four common data 
entry jobs and waybill edit functions using the Workflow Management Console and 
Waybill Entry dialog boxes. 

Chapter 3 Operator Functions describes how operators use the Waiting for Work dialog 
box to receive waybill work assignments.  

Chapter 4 Waybill Field Descriptions define each field in the three waybill dialog boxes: 
Workflow Management Console, Waybill Entry and Waiting for Work. 

Appendix 1 Robot ID explains how to add and assign the Robot ID to a user profile. This 
ID allows users to initiate automated tasks that do not require operator assistance and are 
pre-specified in a waybill. Automated tasks include: importing and mounting images, 
extracting batches, and archiving files. 

Appendix 2 Signatures explains how to create format and autograph book signatures in 
Falcon32. 

Before you start, review the Conventions Used in This Tutorial section that follows. If 
you are not familiar with Windows applications, see the Windows Features section on the 
following page. 
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Conventions Used in This Tutorial 

Conventions are terms (words) and visual representations that help you to find and 
perform the Entrypoint and computer keyboard tasks described in this tutorial: 

This convention... Means this... 

Menu>Option Right angle brackets (>) link a series of menu selections. For example, 
View>ToolBars>Standard Tool Bar instructs you to click on the View 
menu, and then select the Tool Bars and Standard Tool Bar options.  

 

Menu and option items appear in bold letters. 

Key A key on your computer keyboard, such as Enter. 

Key+Key A comma between two keys indicates that you press and release the first 
key, then press and release the next key; example: Alt+N. 

Bold words Button and tab names on computer screens, windows, and dialog boxes; 
examples:  OK, Yes, and Cancel. 

 Identifies a tip to help make your work easier 

Windows Terminology 

This document uses the following standard Windows terminology for mouse actions and 
other Windows tasks. 

This term ... Means this ... 

Click Press the left mouse button. 

Right-click Press the right mouse button. 

Double-click Click (press the left mouse button) twice very quickly. 

Cursor The image on your computer monitor that indicates the mouse position.  It 
can be an arrow, hourglass, or other shape depending on what you are 
pointing at and what you are doing. It moves either when you move your 
mouse or when you click, depending on the current function. 

Click and drag Press and hold down the left mouse button while you pull the mouse along 
your desk to move the cursor or selected item to a different location, or 
select an area. 
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This term ... Means this ... 

Enter Type the letters or numbers indicated, then click OK or press the Enter key. 

Highlight Do one of the following: 

• Place your cursor in front of or after the text or object you wish to 
highlight, then press the left mouse button, hold it down, and drag 
the cursor over the text or object. 

• Click to highlight field contents. 

Select Highlight text or select an option or checkbox option. 

Field An area in a window or dialog box where you can type or select information. 
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Chapter 1 

Introduction 

About Waybill Workflow Management 

Falcon32 workflow management allows supervisors to organize data flow, distributing tasks 
to specific operators by completing and assigning waybill work orders.  

Supervisors create and maintain waybill assignments using the Waybill Entry dialog box. 

Once an operator uses the Waiting for Work dialog box to accept this assignment, the 
supervisor monitors the waybill’s progress using the Workflow Management Console 
dialog box. 

Functions 

Supervisor functions allow you to specify which operators receive work at a specific stage in 
data processing: batch creation, update, verification, extraction, and/or data archival. In 
addition, you have the flexibility to assign one operator in a data entry group to a specific 
batch (or group of batches) or designate any operator in a data group to a specific batch (or 
group of batches). 

Workflow management allows you to automate the following tasks, which previously 
required only operator intervention: extracting verified batches, moving extracted batches to 
a directory for backup, preparing OCR data for inclusion in a batch, and assigning new 
image files to a batch as they are copied to a LAN directory from an external source.  

If you receive a notify or warning message, supervisors can create a diagnostic report 
by right-clicking on a waybill file in the Workflow Management Console dialog box and 
selecting Info from the shortcut menu. 

Operator functions allow you to accept work or reject it so incomplete work is routed to the 
next available operator. Operators can also indicate they are taking a break so Falcon32 
will not reroute incomplete work to another operator. 
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Auditing 

The Workflow Management Console dialog box lists waybill files that store audit 
information and a list of the tasks to be run.  Supervisors can view and edit any waybill.  

As part of the archival process, an XML profile is also generated; it contains the audit trail 
for the waybill if the archive task completes without error. 
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Chapter 2 

Supervisor Functions 

Workflow Management Console (WMC) dialog box 

The Workflow Management Console dialog box is where you create, view, and edit 
waybill files.  

Opening WMC 

Open the Workflow Management Console (WMC) dialog box by selecting View>Workflow 
Management Console…(Ctrl+Y) from the Falcon32 main menu. To perform a variety of 
waybill functions, select a waybill file and then select an option from the Action menu. 

 

Figure 1 Workflow Management Console dialog box: Action menu. 
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Moving and Sorting Columns 

Sortable columns allow you to quickly display the most important work results, such as 
warnings or notifications (Excp [exception] column). To establish a column preference, left 
click on an Action column heading and drag it to the desired column location. In addition, 
click the column to change the sort from ascending (the default) to descending. 

Filtering Columns 

There are multiple ways to filter columns in ascending or descending order:  

• Use the Sort 1-Sort 4 drop-down lists to select an ascending or descending option for 
each column and click Use. 

•  Left-click next to a waybill column heading at the top of the screen while pressing the 
Ctrl key and clicking Sort Now. (These sort results appear in the Sort 1, Sort 2, Sort 3, 
and Sort 4 fields. Click the same waybill column again to sort by D-descending order.) 

For example, to create a four-level sort by Waybill ID, Priority (Pri), Status, and Age, left 
click each of these four columns while continually pressing the Ctrl key. Click Sort Now. 

• Not yet implemented You can select one of the preset options in the Preset drop-down 
list and click Use. 
The results of these preset options are viewable in the Column Filters area. You can 
alter the Preset option you selected in the Column Filters area by single or double-
clicking in the cell area until a drop-down list arrow appears. Then, open the list box 
and select an option. 

All–all jobs display in ascending order. 

Inactive–all unfinished jobs that are currently inactive (the user ID column displays dashes). 

Post-verify–all jobs in either Extract, Archive or Finished status. 

Trouble–all jobs with an N (notify) or W (warning) in the Excp (exception code) 
column. 

Prekey–all jobs in start or create status. 

Not yet implemented 1-Favorite (up to 6-Favorite)–set up to six of your favorite sort 
orders by selecting one of these favorite options,  using the Column Filters area to 
define a Workflow Management Console sort order, and then click Save. 

Click the Auto Refresh button to continually refresh waybill data (and columns) every 
30 seconds. (The Refresh button disables when Auto Refresh is active.) 

To perform a manual refresh of waybill data (and columns), click the Refresh button. (If 
the Refresh button is disabled, the Auto Refresh function is turned on. Click the Auto 
Refresh button to return to manual refresh mode.)
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Task Groups 

About Task Groups 

In order to set up waybill assignments, you should create task groups and assign users to 
them.   You can assign individual users, but this will restrict work on a waybill to the 
availability of that single user. 

A list of Falcon32 user IDs and supervisor defined task Groups will appear in every Task 
Assignments drop-down list in the Waybill Entry dialog box. Task groups appear prefixed 
with a pound # sign. See Figure 2 Task Assignment Categories. 

 

Figure 2 Task Assignment Categories 

It is recommended you create task group names that match task assignment categories in 
the Assignments tab of the Waybill Entry dialog box. See Table 1 for task assignment 
descriptions. 
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Table 1 Assignments Tab: Task Definitions 

Task Description 

Create Allows the selected person or group to create a batch. (Assigning images for KFI is done 
immediately after you click Release on the Waybill Entry dialog box. Importing images 
or text, pre-recording, and starting an expedited batch is handled by the person or group 
listed in the Automate drop-down list.) 

Update Allows the selected person or group to make edits to an existing batch. If an operator suspends a 

batch, it remains in the Update state. (Once an operator finishes creating a batch by saving 
it, it changes immediately to a Verify task.) 

Verify Allows the selected person or group to verify a batch. Once the operator finishes verifying 
the batch and saves it, the batch is ready for extraction.  
(The supervisor can select the Notify user or group option, located in the Verify tab, 
which suspends this state until the supervisor clears the notification by right-clicking a 
waybill in the Workflow Management Console dialog box and selecting the Clear 
Exception to run option. Make sure you select the person or group who can receive the 
Notify user or group notification that the batch is ready to verify.) 

Extract Falcon32 automatically extracts the verified batch, unless this stage of work is set to the 
Notify user or group option. This automated task can be performed at an unattended 
work station by one or more people assigned via the Assignments tab. (Make sure you 
select the operator or group that can receive the notification that a batch is ready for 
extraction.) 

Archive Falcon32 automatically archives the extracted batch, unless this stage of work is set to 
the Notify user or group option. This automated task can be performed at an 
unattended work station by one or more people assigned via the Assignments tab. 
(Make sure you select the person or group who can receive the notification that a batch is 
ready for archiving.)  

Warnings Allows the selected person or group to be notified if a waybill is suspended because it 
has generated warnings. Warning examples: no valid user ID to assign a task, failed 
extraction. See the Wait to warn (hours) topic below. 

Automate Automated tasks can be performed at an unattended workstation by one or more people 
assigned via the Assignments tab. The eligible operator logs on and opens the Waiting 
for Work dialog box to initiate the automated process. These processes include: 
importing images or text, prerecording, starting an expedited batch, extracting and 
archiving a batch. If the waybill specifies that Falcon32 should skip verification, the batch 
performs a “quick verify.” (Eligible operators can disable accepting automated tasks by 
selecting the Do not accept automated tasks check box in the Waiting for Work dialog 
box.) 
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ANYOPER - A Task Group that Makes All Users Eligible for a 
Task 

By using the built-in #ANYOPER task group, you tell Falcon32 that any logged on user is 
eligible to perform the specific task.  The group is always up-to-date, thus you can view a 
list of all available user IDs assigned to Falcon32 using the Task Groups feature. 

To view a list of all available users: 

1. Logon to Falcon32 as a supervisor. 
The Workflow Management Console dialog box either opens automatically or you 
can open it by selecting View>Workflow Management Console…(Ctrl+Y) from 
the Falcon32 main menu. 

2. From the Action menu, select Task Groups… 
The Task Groups dialog box opens. 

3. Select the ANYOPER option from the Task Group drop-down list. 

4. Click Edit. 
A list of all available users display. 

 

Figure 3 View all available users for any task group. 
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Create Task Group 

You can create user task groups that are eligible perform the following tasks identified in the 
Assignments tab of the Waybill Entry dialog box: Create, Update, Verify, Extract, Archive, 
Warnings, and Automate. Any task group can be assigned to any combination of tasks.  See 
Table 1 Assignments Tab: Task Definitions on a previous page for an explanation of each 
category. 

You can also create arbitrary task groups, for example, data entry operators allowed to 
create and update batches. The task group for data entry operators using workstations 
licensed for OCR work could be called DEOCR and non OCR operator work assignments 
could be assigned to a DEOnly task group. 

Note: The only existing task group is ANYOPER; it lists all existing Falcon32 user IDs and 
is maintained by Falcon32.  It cannot be changed. 

To create a task group: 

1. Logon to Falcon32 as a supervisor. 
The Workflow Management Console dialog box either opens automatically or you 
can open it by selecting View>Workflow Management Console…(Ctrl+Y) from 
the Falcon32 main menu. 

2. From the Action menu, select Task Groups… 
The Task Groups dialog box opens. 

3. Click New. 
The Name Task Group dialog box opens. 
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Figure 4 Create task group.  

4. Type the name of the group in the Name field (e.g., DEOPER (Data Entry 
operators), VEROPER (verify operators), ROBOT (tasks set as automated (i.e., 
extract, archive and start), WARNING (supervisors who receive all waybill 
notifications and warnings). 

5. Click OK. 
The new name displays in the Task Groups dialog box. 

Assign User to Task Group 

You can assign more than one user to a task group. 

To assign a user to a task group: 

1. Logon to Falcon32 as a supervisor. 
The Workflow Management Console dialog box either opens automatically or you 
can open it by selecting View>Workflow Management Console…(Ctrl+Y) from 
the Falcon32 main menu. 

2. From the Action menu, select Task Groups… 
The Task Groups dialog box opens. 
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3. Select a task group from the Task Group drop-down list. 

4. Click Edit. 
All available user IDs display. 

Note: If a user was permanently deleted from the Falcon32 system using the 
Option>Security Properties… function, their name appears grayed out, along 
with a cleared and grayed out check box. You will be unable to select it. 

 

Figure 5 Add user to task group. 

5. Select the check box next to one or more names. 

6. Click Accept. 

7. Click Close. 

8. Once you create a new waybill, and click the Assignments tab, you can now 
associate the group with one of the following assignments: Create, Update, Verify, 
Extract, Archive, Warnings, and Automate. 
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Delete Task Group 

You can delete a task group using the Task Groups option. 

To delete an entire group category: 

1. Logon to Falcon32 as a supervisor. 
The Workflow Management Console dialog box either opens automatically or you 
can open it by selecting View>Workflow Management Console…(Ctrl+Y) from 
the Falcon32 main menu. 

2. From the Action menu, select Task Groups… 
The Task Groups dialog box opens. 

3. Select the correct task group from the Task Group list. 

4. Click Edit. 
The selected check boxes identify the current group members. 

 
Figure 6 Delete Task Group. 

5. Click Delete. 
A prompt opens, asking if you want to permanently delete the task group. 

6. Click Yes. 
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Delete User From Task Group 

You can delete a user from one or more task groups. 

To delete a user(s) from a task group: 

1. Logon to Falcon32 as a supervisor. 
The Workflow Management Console dialog box either opens automatically or you 
can open it by selecting View>Workflow Management Console…(Ctrl+Y) from 
the Falcon32 main menu. 

2. From the Action menu, select Task Groups… 
The Task Groups dialog box opens. 

3. Select the correct group from the Task Group list. 

4. Click Edit. 
The selected check boxes identify the current group members. 

 
Figure 7 Delete user from task group. 

5. Clear one or more check boxes of task group members. 

6. Click Accept. 

7. Click Close.
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Creating New Waybill 

Create a waybill to automate data entry and verification tasks.  Our examples will 
demonstrate creating Key-from-Paper and Key-from-Image workflows.  Workflows that also 
do OCR are similar to Key-from-Image workflows but with additional options. 

Note: After you select the settings for a new waybill, you can name and save it as a 
template for a specific waybill task by selecting the Save As… option from the Waybill 
template drop-down list. The Save Waybill As Template dialog box opens. Type a 
descriptive template name in the File name field and click Save. Then, click OK after the 
Waybill dialog box opens to finish naming the template. 

To create a new waybill: 

1. Logon to Falcon32 as a supervisor. 
The Workflow Management Console dialog box either opens automatically or you 
can open it by selecting View>Workflow Management Console…(Ctrl+Y) from 
the Falcon32 main menu. 

2. From the Action menu, select New Waybill…(Ctrl+N) 
The Waybill Entry dialog box opens. 

Note: This discussion below assumes that you are working with the tabbed version 
of the Waybill Entry dialog.  If the expanded version of the Waybill Entry dialog 
box displays, click the With Tabs button to display the tabbed (condensed) version. 

Creating a Single Batch Assignment for Key-from-Paper 

The following instructions show you how to use the Workflow Management Console to 
create and dispatch a key-from-paper batch work assignment. 

To assign a key from paper batch work assignment: 

1. From the Workflow Management Console main menu, left click the Action menu and 
select New Waybill… 
The Waybill Entry dialog box opens. 

2. Click the Waybill tab and select a waybill creation option; keying from paper always 
requires the Create a batch default option. 

3. Click the Verify tab and select the Key verify the batch option. 

4. Click the Extract tab and select an extract action; Auto-extract is the default option. 

Not yet implemented Manual Extraction Note: If the operator manually extracts a 
batch that is part of a waybill, it automatically proceeds to the Archive waybill stage. 
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5. Select the Untranslated extract type (default option). 

6. Click the Archive tab; Auto-archive extracted batch is the default option. 

7. In the Archive tab, select the Do nothing option to leave the relevant file (i.e., batch 
.fbf file) in the relevant directory (i.e., dat) for the following areas: Batch File, Sidecar 
Files, and Copy/Moved Image or Text Files. 

Notes: 

• If the Imaging Add-on is not installed, the Sidecar Files area is grayed out. An .fsd 
sidecar file is created when Falcon32 is working with imaging files. 

• The Delete file option removes the relevant file (i.e., batch .fbf file) from the 
relevant directory (i.e., dat) while the Archive file option moves the relevant file 
from the relevant directory to the Waybill directory. 

• Select the Change batch status to PROD check box to set the internal Falcon32 
batch status to PROD to make it easier to manually rerun a batch extraction. 

8. (Optional) The Archive Files Target Directory drop-down list specifies the storage 
location of the archive file. Click Browse… to select a directory. 

• If left blank, files are archived in the Falcon32 Waybill directory 
(Falcon32\Waybill). 

• If you select a target directory and clear the External Only check box, files are 
archived in both the Falcon32 waybill directory and the specified target 
directory. 

• If you select a target directory and select the External Only check box, files 
are only archived in the specified target directory. 

9. Click the Assignments tab to assign a user or work group eligible to perform the 
following tasks. If it doesn’t matter who performs the task, select the #ANYOPER (any 
operator) default group ID option.  

Note: Since you set Extract and Archive tasks to automated, assign user IDs or task 
groups have the correct permissions. Automated assignments are dispatched to 
operators after all create, update and verify batch tasks are exhausted. See Appendix 
1 Robot ID for more information about setting permissions.  

10. Click the Create tab and select a previously selected application from the Assign 
Application drop-down list. Or, to select a different application, click this drop-down list 
and choose Select… to open the Assign Application dialog box, left click an application 
and choose Select to return to the Waybill Entry dialog box with the new application 
selected.  

Note: If the application doesn’t automatically name the batch, you will see question 
marks appear in an editable Batch name field, signifying you need to name the batch. 
(Proper workflow management does not allow the operator to name a batch.) 
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11.  (Optional) Type an instructional note for an operator in the Instructions to Operator 
field. 

12.  (Optional) Create a waybill template: Name and save the current waybill settings for 
paper keying a single batch by selecting the Save As… option from the Waybill 
template drop-down list. The Save Waybill As Template dialog box opens. Type a 
descriptive template name in the File name field and click Save. Then, click OK after 
the Waybill dialog box opens to finish naming the template. 

Future Template Use Note: Save all the previous keying steps by using a previously 
saved template.  From the Waybill Entry dialog box, select the saved template from 
the Waybill template drop-down list, and if the application doesn’t automatically name 
the batch, click the Create tab to name the batch in the Batch name field and click 
Release. 

13. Click Release. 
The Waybill file generates and appears in the Workflow Management Console dialog box. 

14. In the Workflow Management Console, click the Age column to set it to descending 
order. (The Sort 1 field will display Age-D (descending). See Chapter 4, Waybill Field 
Definitions, for a description of each waybill column. 
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Creating Multiple Batch Assignments for Key-from-Paper 

The following instructions show you how to use the Waybill Generator feature to create and 
dispatch multiple key-from-paper batch work assignments. 

To assign multiple key from paper batch work assignments: 

1. From the Workflow Management Console main menu, left click the Action menu and 
select New Waybill… 
The Waybill Entry dialog box opens. 

2. Click the Waybill tab and select the Waybill generator: Paper workflow option and 
then select the number of waybills to generate in the Count field. 

Note: This option only allows you to select applications that auto-name the batch. 
If you need to manually name (replaceable characters) your batches, you must create 
each waybill individually. 

3. Follow steps 3-8 in the Creating a Single Batch Assignment for Key-from-Paper 
procedure. 

4. Click the Create tab and select a previously selected application from the Assign 
Application drop-down list. Or, to select a different application, click this drop-down list 
and choose Select… to open the Assign Application dialog box, left click an 
application and choose Select to return to the Waybill Entry dialog box with the new 
application selected.   

5.  (Optional) Type an instructional note for an operator in the Instructions to Operator 
field. 

6.  (Optional) Create a waybill template: Name and save the current waybill generator 
settings for paper keying multiple batches by selecting the Save As… option from the 
Waybill template drop-down list. The Save Waybill As Template dialog box opens. 
Type a descriptive template name in the File name field and click Save. Then, click OK 
after the Waybill dialog box opens to finish naming the template. 

Future Template Use Note: Save all the previous keying steps by using a previously 
saved template.  From the Waybill Entry dialog box, select the saved template from 
the Waybill template drop-down list, and if the application doesn’t automatically name 
the batch, click the Create tab to name the batch in the Batch name field and click 
Release. 

7. Click Release. 
Multiple waybill files generate and appear in the Workflow Management Console 
dialog box. 

8. In the Workflow Management Console, click the Age column to set it to descending 
order. (The Sort 1 field will display Age-D (descending). See Chapter 4, Waybill Field 
Descriptions for a description of each waybill column. 
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Creating Multiple Batch Assignments for Key-from-Image 

The following instructions show you how to use the Waybill Generator feature to create and 
dispatch multiple key-from-image batch work assignments.  This workflow is available only 
if the Imaging Add-on is installed and licensed. 

To assign multiple key from image batch work assignments: 

1. From the Workflow Management Console main menu, left click the Action menu and 
select New Waybill… 
The Waybill Entry dialog box opens. 

2. Click the Waybill tab and select the Waybill generator: Use new files in the “live” 
directory option.  If this option is grayed out, do step 5 and return to this step. 

Note: This option only allows you to select applications that auto-name the batch. If you 
need to manually name (replaceable characters) your batches, you must create each 
waybill individually. 

3. Follow steps 3-8 in the Creating a Single Batch Assignment for Key-from-Paper 
procedure. 

4. From the Create tab, select: 

• a previously selected application from the Assign application drop-down list. Or, 
to select a different application, click this drop-down list and choose Select… to 
open the Assign Application dialog box, left click an application and choose 
Select to return to the Waybill Entry dialog box with the new application selected. 

Batch Note: You will not be allowed to select an application that doesn’t 
automatically name the batch. (Proper workflow management does not allow the 
operator to name a batch.) 

Note if the Assign application drop-down list is locked: Selecting an autograph 
book (.book), disables the Assign application drop-down list because the 
autograph book identifies the application associated with the first image in the 
batch. (An autograph book is a collection of format signatures that identify and 
open an application for the user to start a new batch for keying. The .book file also 
identifies the first format in a batch.) For this example, do not use an autograph 
book.  Clear the Form identification drop-down.  Once you move the cursor from 
the field, the Assign application field will open.  See Appendix 2, Signatures, for 
detailed Signatures feature information. 

5. From the Create tab, select the Assign images for KFI option. (You can select other 
image options but this example uses a commonly performed option.) 

6.  (Optional) Type an instructional note for an operator in the Instructions to Operator field. 

7. Click the Import tab and use the Live directory drop-down list to select a previously 
selected directory to automatically load files into the workflow. Or, to select a different 
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directory, click this drop-down list and select Browse… to open or create a new directory 
and then click OK to return to the Waybill Entry dialog box with the new directory 
selected.. (“Live” applies to directories that do not contain a fixed number of files because 
they often receive new files.)  A good strategy for this type of workflow is to create a 
different live directory for each Falcon32 application used to key images for that application.  
If you mix images for different applications, you will need to use an autograph book to look 
at the first image in the file to determine the correct application. 

Note: The Live directory, File name and Extension fields in the Live Import (waybill 
auto-creation only) area became active when the Waybill generator: Use new files in 
the “live” directory option on the Waybill tab in step 2 was selected. 

8. Select a file from the File name drop-down list. If you need to select a different file name, 
you can type the file name, omitting the file extension. (You can type a file name prefix and 
asterisk to select all the files beginning with this file name, i.e.,Pay*.) 

9. From the Extension drop-down list, select the extension used by the selected file(s) in the 
File name and Live directory (location) drop-down list. If you need to select a different 
extension, select New… to open the Create Custom Type List dialog box and select an 
extension type from the supported file types listed.  

10. On the Import tab, select one of the following ways to use the selected files. For this 
example, select the Copy to work directory option. 

• The Move to work directory option (default) moves selected files from the 
source directory to the Falcon32 Waybill\Work directory. The subdirectory 
name created by Falcon32 is the name of the waybill being created. 

• The Copy to work directory option copies selected files from the source 
directory to the Falcon32 Waybill\Work directory. (One example of when you 
may use this option is if you specified a LAN directory that receives files via 
FTP) The subdirectory name created by Falcon32 is the name of the waybill 
being created. 

• The Use in place directory option uses the selected files from the source 
directory; it will not copy or move files to another directory.  

Note: These source directories must be available to all operators using the 
same directory path, in order to use the files. 

11. (Optional) Select the Hide file after selecting check box to assign the DOS hidden file 
attribute to files to indicate they were already selected and will not appear (or be grayed 
out, depending upon your Windows settings) in the Open dialog box when you click the 
Select Files button. This protects against selecting the same files and is recommended 
for the Copy to work directory and Use in place directory options in step 10. If this 
attribute is selected, a file will not be hidden if the waybill is cancelled before it is 
released, if you cancel and select other files, or if you delete a waybill before extraction 
(using the Delete Waybill and Restore Imports function in the Workflow Management 
Console).  
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Note: This option is only available if you select either the Copy to work directory or 
Use in place directory options. 

12.  (Optional) Click the Waybill tab and specify the number of images or text files to 
incorporate into each batch in the Count needed for new waybill field. If your images 
are stored as one image per file, choose a number consistent with your data entry 
work. Usually, an average of 25 images is assigned to each batch. If your images are 
stored together (i.e., batched) in multi-page files, 1 (default) is usually correct. 

13. Select the Waybill is finished when all files in the “live” directory are processed 
so the waybill will process all the files in the live directory, create a final partial batch if 
needed, and then send a final waybill to the Workflow Management Console dialog 
box with a Finished status. 

Note: If this option is not selected, Falcon32 will periodically check the indicated “live” 
directory for new files AND it will not change the waybill generator's status to Finished 
in the Workflow Management Console dialog box. In this case, Falcon32 will not 
generate partial batches until an interval has passed. To set the interval, type a number 
in the Delay before generating partial waybill (minutes) field.  This "set-once" 
feature allows you to create a waybill generator that will perpetually create new batches 
as images are loaded into the "live" directory.  For that reason, it never is "finished" 
working. 

14. (Optional) Create a waybill template: Name and save the current waybill generator 
settings for image keying multiple batches by selecting the Save As… option from the 
Waybill template drop-down list. The Save Waybill As Template dialog box opens. 
Type a descriptive template name in the File name field and click Save. Then, click OK 
after the Waybill dialog box opens to finish naming the template. 

Future Template Use Note: Save all the previous keying steps by using a previously 
saved template.  From the Waybill Entry dialog box, select the saved template from 
the Waybill template drop-down list, and if the application doesn’t automatically name 
the batch, click the Create tab to name the batch in the Batch name field and click 
Release. 

15. Click Release. 
Multiple waybill files generate (including a single waybill generator file) and appear in 
the Workflow Management Console dialog box. In addition, Falcon32 generates 
batches from the waybill generator once a user with permissions to run automated 
tasks opens the Waiting for Work dialog box. 

16. In the Workflow Management Console, click the Age column to set it to descending 
order. (The Sort 1 field will display Age-D (descending). See Chapter 4, Waybill Field 
Definitions for a description of each waybill column. 
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Creating an Individual Batch Assignment for Key-from-Image 

The following instructions show you how to use the Workflow Management Console to 
create and dispatch an individual key-from-image batch work assignment. 

To assign an individual key from image batch work assignment: 

1. From the Workflow Management Console main menu, left click the Action menu and 
select New Waybill… 
The Waybill Entry dialog box opens. 

2. Click the Waybill tab and select the Create a batch option. 

Note: The Create a Batch option allows you to select applications that either auto-
name batches or require you to manually name your batches. 

3. Follow steps 3-8 in the Creating a Single Batch Assignment for Paper Keying 
procedure. 

4. From the Create tab, select: 

• a previously selected application from the Assign Application drop-down list. Or, 
to select a different application, click this drop-down list and choose Select… to 
open the Assign Application dialog box, left click an application and choose 
Select to return to the Waybill Entry dialog box with the new application selected. 

• Batch Note: If the application doesn’t automatically name the batch, you will see 
question marks appear in an editable Batch name field, signifying you need to 
name the batch. (Proper workflow management does not allow the operator to 
name a batch.) 

Note if the Assign application drop-down list is locked: Selecting an autograph 
book (.book), disables the Assign application drop-down list because it identifies 
the application associated with it. (An autograph book is a collection of format 
signatures that identifies and opens an application for the user to start a new batch 
for keying. The .book file also identifies the first format in a batch.) For this 
example, do not use an autograph book.  Clear the form identification drop-down.  
Once you move the cursor from the field, the Assign application field will open. 
See Appendix 2, Signatures, for detailed Signatures feature information. 

5. From the Create tab, select the Assign images for KFI option. (You can select other 
image options but this example uses a commonly performed option.) 

6. (Optional) Type an instructional note for an operator in the Instructions to Operator 
field. 

7. Click the Import tab and click Select Files.  
The Select Images dialog box opens. 

8. Select an image and then click OK to return to the Waybill Entry dialog box.  
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Note: The Select Files button became active when the Create a batch option in step 2 
was selected. 

9.  (Optional) Create a waybill templage: Name and save the current waybill generator 
settings for image keying an individual batch by selecting the Save As… option from 
the Waybill template drop-down list. The Save Waybill As Template dialog box 
opens. Type a descriptive template name in the File name field and click Save. After 
the Waybill dialog box opens, click OK to finish naming the template. 

Future Template Use Note: Save all the previous keying steps by using a previously 
saved template.  From the Waybill Entry dialog box, select the saved template from 
the Waybill template drop-down list, and if the application doesn’t automatically name 
the batch, click the Create tab to name the batch in the Batch name field and click 
Release. 

10. Click Release. 
An individual waybill file generates and appears in the Workflow Management 
Console dialog box. 

11. In the Workflow Management Console, click the Age column to set it to descending 
order. (The Sort 1 field will display Age-D (descending). See Chapter 2, Supervisor 
Functions, Filtering Columns section for details. 
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Editing Tasks 

Editing Waybills 

You can edit an existing waybill using the Workflow Management Console. 

To edit a waybill: 

1. Logon to Falcon32 as a supervisor. 

2. Select View>Workflow Management Console…(Ctrl+Y) from the Falcon32 main 
menu to open the Workflow Management Console (WMC) dialog box. 

3. Double-click on a waybill file or select Edit Waybill…(Ctrl+O) from the Action 
menu. 
The Waybill Entry dialog box opens. 

4. Make the appropriate edits. If waybill settings are changed, the settings become 
the default options when you create a new waybill. 

Note: If you need to correct mistakes in a waybill file but the fields needed are not 
editable, you will need to delete (purge) and recreate the waybill(s). 

Change Waybill Priority Level 

You can manually change the waybill priority level using the Workflow Management Console 
dialog box. 
 
To change a waybill priority level: 
 
1. From the Workflow Management Console, right-click a waybill and select one of the 

following priority levels: 

• 0=stop (Ctrl+0) A zero setting prevents the waybill from being dispatched to an 
operator, though you can still create and release it to appear in the Workflow 
Management Console dialog box. 

• 1=lowest (Ctrl+1) This is the lowest priority status. 

• 2=lower (Ctrl+2) 

• 3=low (Ctrl+3) 

• 4=below normal (Ctrl+4) 

• 5=normal (Ctrl+5) A setting of five is the default priority. 

• 6=above normal (Ctrl+6) 

• 7=high (Ctrl+7) 

• 8=higher (Ctrl+8) 

• 9=highest (Ctrl+9) This is the highest priority status. 
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Clear Exception State and Run 

If the waybill specifies a Notify user or group option at some point in the workflow or 
generates a warning exception, the batch is prevented from being dispatched to the next stage. 
To override this and dispatch the waybill to run at the same workflow stage, a supervisor can 
override this in the Workflow Management Console dialog box by right-clicking on the waybill 
and selecting the Clear Exception State and Run option. 

 
What caused the notification or warning?  Right-click on the waybill and select Info. 

Note: If you want to prevent the waybill from being dispatched yet clear the exception, 
right-click the waybill and select 0 Stop. Then, right-click again on the waybill, and select the 
Clear Exception State and Run option. Once you are ready to release the assignment, set the 
waybill to any priority number from 1-9.  

Clear Exception State and Skip 

If the waybill specifies a Notify user or group option at some point in the workflow or 
generates a warning exception, the batch is prevented from being dispatched to the next stage. 
To clear this hold and omit the next stage, a supervisor can override this in the Workflow 
Management Console dialog box by right-clicking on the waybill and selecting the Clear 
Exception State and Skip option. 
 
What caused the notification or warning?  Right-click on the waybill and select Info. 

Change Waybill Status to Update 

You may want to change a waybill from Verify to Update status for a variety of reasons: a 
batch was incorrectly sent to verify mode, you need to add additional records, there were batch 
import errors. To change a waybill status to update, right-click on the waybill in the Workflow 
Management Console dialog box and select the Set Update Status option.  

Unlock Waybill 

A locked waybill usually means someone is working on the batch. You can unlock a waybill to 
allow assigned operators to work on the batch by right-clicking on the waybill in the Workflow 
Management Console and selecting the Unlock Waybill option. 

Warning: Do not unlock a batch unless you are sure the batch listed in the Batch column of the 
Workflow Management Console dialog box is “stranded.” Instead, rescue the batch by using 
the Batch>Open a Stranded Batch function in the Falcon32 main menu  

Purge Waybill (but not data) 

You can delete a waybill (but not its related files in the Waybill\Work subdirectory) by right-
clicking on the waybill in the Workflow Management Console and selecting the Purge 
Waybill (DEL) option. Depending upon the archive and extract options you set for the waybill, 
the subdirectory with the same name as the purged waybill (e.g., 
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N:\Falcon32\Waybill\Work\20080130Wed220423227) could still contain the batch (or a copy), 
the extract (or a copy), sidecar files, and an XML file containing the audit trail for the waybill if 
the archive task completed without error. 

Delete Waybill Complete 

You can delete a waybill and its related files in the Waybill\Work subdirectory by right-clicking 
on the waybill in the Workflow Management Console and selecting the Delete Waybill 
Complete (Ctrl+DEL) option.  

Depending upon the archive and extract options you set for the waybill, the waybill work 
directory could still contain the batch (or a copy), the extract (or a copy), sidecar files, and an 
XML file containing the audit trail for the waybill if the archive task completed without error. 

Warning: Use this command with caution and only after backing up data. 

Delete Waybill Complete after Restoring Imports 

Use this option if you want to create a new waybill using images previously assigned to a 
waybill you are completely deleting. This function returns to the source image directory the 
image files that the program copied or moved to the Waybill\Work subdirectory.  This is done 
before subsequently deleting the waybill and its related files from the Waybill\Work 
subdirectory (as is done in the Delete Waybill Complete function).  

To perform this task, right-click on the waybill in the Workflow Management Console and 
select the Delete Waybill Complete after Restoring Imports…(Shift+Ctrl+DEL) option. 

Note: Image files move when a user creates a waybill and selects the Move to work directory 
option in the Import tab.  
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Chapter 3 
Operator Functions 

 

Waiting for Work dialog box 

Falcon32 uses the Waiting for Work dialog box to dispatch work into the managed 
workflow, assigning entry, verify, and automated jobs to operators.  Typically, one instance 
of Falcon32 displaying the Waiting for Work dialog is configured to run automated tasks.  
Operators will then receive work as it is automatically added to the workflow. 
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Figure 8 Waiting for Work dialog box. 
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Opening the Waiting for Work Dialog 

You can open the Waiting for Work dialog box in an automated or non automated manner. 

To open the Waiting for Work dialog box automatically upon logon, in the Falcon32 main 
menu, update the operator’s logon password via Option>Security Properties. See 
Appendix 1, Add Automated Waybill Permissions to Existing User topic to learn how to 
update these permissions. 

Otherwise, select Batch>Waiting for Work...(Ctrl+E) from the Falcon32 main menu. 

Accepting a Job 

At the bottom of the Waiting for Work dialog box, a message appears, letting the user 
know the tasks their logon password is eligible to perform. If entry and verify tasks are not 
mentioned, only automated tasks will run. 

To accept work, click Accept before the Time Left field counts down to 0. The Time Left 
field counts the time a dispatched job is available for the operator to accept before it is 
routed to the next available operator. 

Automated Jobs Note: If the Task type field indicates Auto, the task automatically runs, 
eliminating the need for operator intervention. 

Rejecting a Job 

To reject work click Reject or let the Time Left field expire.  The next available job will then 
be offered. 

Expediting Work 

The Expedite work check box is activated when the user first selects this option and then 
accepts a job. Once this job is complete and the user saves it, the Accept and Reject 
options disable so the operator can receive the next and subsequent jobs immediately. To 
enable the Accept and Reject options again, cancel the current job.  

Looking for Work 

The Look Now button appears when there is no eligible work for an operator and the 
system will search at the end of the Time Left field countdown. Click Look Now to search 
for available work before the Time Left field countdown ends. 

Close the Waiting for Work Dialog 

• The Close button returns you to the Falcon32 main menu.  
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Note: The Close button displays instead of the Logoff button if a user manually opens 
the Waiting for Work dialog box using Ctrl+E or selecting Batch>Waiting for Work… 
from the Falcon32 main menu.  
 

• The Logoff button not only closes the Waiting for Work dialog box but logs you off 
from Falcon32.  

 
Note: The Logoff button displays instead of the Close button if you select the Always 
use the Waiting for Work dialog check box or you workstation has been configured to 
only allow the Waiting for Work dialog to display. 
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Chapter 4  

Waybill Field Descriptions 

Supervisor 

Workflow Management Console Columns 

The following information defines each Workflow Management Console column. See 
Chapter 2, Supervisor Functions, for specific procedures that show how supervisors can 
use the functions in this dialog box. 

 

Figure 9 Workflow Management Console dialog box. 

The Way bill ID column identifies the waybill by its auto generated file name; the file name 
is based on coordinated universal time (UTC). 
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The Pri (priority) column lists the waybill’s priority of completion. After an operator 
completes a job, the highest priority work appears next. The default priority is 5 and the 
range is 0-9, nine being the highest priority. Set a waybill to 0 to prevent it from being 
dispatched. 

Note: If all waybills were set at the standard default priority of 5, the highest priority 
tasks are: expedited waybills, create (i.e., importing images or text, pre-recording), update 
and verify tasks. If no waybills for these tasks exist, waybills needing to Start, Qverify, 
Extract, and Archive dispatch. 

The Expd (expedited) column identifies with a Y (yes) or N (no) waybill files marked as 
expedited or given higher priority than waybills with the same numerical priority.  
 

Supervisors can expedite the following work using the Waybill Entry dialog box: 
 

• Creating a new waybill with (pre-recorded or import) imaging: Click the Create 
tab and select the Expedite (Pre-record and/or import) option. 

 

• Creating any new or editing any existing waybill: Double-click a waybill file, 
move the Priority slider to a higher level, and click Release.  

 
Operators can expedite a waybill by selecting the Expedite work check box on 
the Waiting for Work dialog box. See Chapter 3, Expediting Work section, for 
more details. 

 
The Status column identifies the next stage of work to be done. 
 

Create–generate a new batch by data entry. 

Start–run the set up task (i.e., pre-record OCR) specified in the Create tab of the 
Waybill Entry dialog box. 

Update–perform additional data entry to an existing batch suspended due to 
incomplete key entry or verification. 

Verify–verify the batch 

QVerify (Quick Verify) –the supervisor opted to skip the verify stage; the waybill moves 
to the next stage of work by flagging records and batches as if they were verified. 

Extract–run the extract task (i.e., auto-extract, extract to untranslated data or XML) 
specified in the Extract tab of the Waybill Entry dialog box. 

Archive–run the archive tasks specified in the Archive tab of the Waybill Entry dialog 
box. 

Finish–all work is completed. 

 
The Excp (exception) column identifies if the waybill file requires a supervisor’s attention.  
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Review warnings and notifications by right-clicking on the waybill and selecting Info from 
the shortcut menu. 
 

--- (dashes)–the waybill is running normally. 
 

N (notify) –the waybill specified the Notify user or group option at some point in 
the workflow. Supervisors can prevent the batch from being dispatched at a certain 
point in the process. For example, the supervisor can set a waybill to go into notify 
status once batches are ready for verification or extraction. A supervisor can 
override this in the Workflow Management Console by right-clicking on the 
waybill and selecting the Clear Exception to Run option. 
 

W (warning)–the waybill is prevented from being dispatched because something 
unexpected occurred. In the Assignments tab of the Waybill Entry dialog box, the 
Warnings option lists one or more operators eligible to work on the common 
problems that issue a warning, like invalid user assignments, unprocessed batches, 
etc.   
 
 

The Type column categorizes the various icons in the Waybill ID column into two groups. 
 

Type of waybill: W (waybill generator - a waybill that generates waybills) and B 
(waybill that tracks a batch) refer to how the waybill was generated. 
 

Types of workflow: P (paper), K (key-from-image), and O (OCR). 
 

The User ID column identifies the user currently performing work from that waybill, noted 
also by a blue icon in the Waybill ID column. A series of dashes means no work is currently 
being done for that waybill. 
 

The Appl (application) column identifies the application name assigned to the waybill. A 
series of dashes means there is no application name associated with the batch. 
 

The Batch column identifies the batch name attached to the waybill. A series of dashes 
means there is no batch name associated with the waybill. 
 

The Eligible column identifies which user or task group (if preceeded by a # symbol) is 
eligible for the work (AMY, #DEOPER, #ANYOPER). A series of dashes means there is no 
one eligible. 
 

The Timestamp column identifies when the waybill was created. 
 

The Age column identifies how long the waybill has been in existence. 
 

The Lic (licensing) column identifies the licensing required in order for an assigned operator 
to be able to complete the task at their workstation. If a group of incomplete waybills display 
the same number in this column, it may indicate the workstation isn’t licensed to process a 
particular waybill task. See Table 2 Required License Definitions. 

Table 2 Required License Definitions 

Code Required licenses 
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– None 

1 OCR required for START tasks. KFI required for CREATE, UPDATE, and VERIFY tasks. 

2 KFI required for CREATE, UPDATE, and VERIFY tasks. 

3 OCR required for CREATE and UPDATE tasks. KFI required for CREATE, UPDATE, and VERIFY 
tasks. 
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Waybill Entry Fields 

The following information defines each Waybill Entry field. See Chapter 2 Supervisor 
Functions, for specific procedures that show how supervisors can use these functions to 
create waybills for a variety of jobs. 

The dialog will disable certain controls based on context.  By changing or setting certain 
options, other options may enable or disable.  When tabs are shown (with tabs or 
"collapsed"), be aware that the change may occur on a tab other than the current tab. 

There are two ways to view the Defining Waybill Entry dialog box: expanded (without tabs) 
and collapsed (with tabs). 

 

Figure 10 Waybill Entry dialog box: expanded.
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Figure 11 Waybill Entry dialog box: collapsed. 

Outside of Tab Area 

The Author(s) drop-down list indicates all users who have edited the waybill. 

(Optional) Select a saved waybill template from the Waybill template drop-down list to 
quickly create a new waybill with specific parameters. Select Save As… from the Waybill 
template drop-down list to name and save current waybill settings as a template.  

Click the left arrow button to vertically place the Waybill tabs (Import, Create, Verify…) to 
the right of the Waybill Entry dialog box. 

Click the Release button to dispatch a new waybill into the managed workflow. If you 
updated an existing waybill, the new settings take effect immediately if the batch is not in 
use. If in use, the changes take effect after the batch is saved, suspended, cancelled, or the 
task is completed. 

Click the Cancel/Close button to close the Waybill Entry dialog box. 

Click the Without Tabs button to expand the waybill to view all fields without tab 
separators. 
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Click the With Tabs button to collapse the waybill to view fields, organized by tab 
separators. 

Click Help to open the Help topic for this dialog box. 

When creating a new waybill or editing an existing one, you can move the Priority 
slider to set a lower or higher priority level for a waybill you are creating (After you finish 
setup, clicking Release saves this priority.) The priority levels are:  

0=stop (Ctrl+0) A zero setting prevents the waybill from being dispatched to an operator, though you 
can still create and release it to appear in the Workflow Management Console dialog box. 

1=lowest (Ctrl+1) This is the lowest priority status. 

2=lower (Ctrl+2) 

3=low (Ctrl+3) 

4=below normal (Ctrl+4) 

5=normal (Ctrl+5) A setting of five is the default priority. 

6=above normal (Ctrl+6) 

7=high (Ctrl+7) 

8=higher (Ctrl+8) 

9=highest (Ctrl+9) This is the highest priority status. 

Create Tab 

The Create tab is the default customization tab that displays whether creating or viewing a waybill. 



Chapter 4 
Waybill Field Descriptions 

Tutorial 40 

 

 

Create Task Options 

The Form Identification drop-down list displays previously selected **autograph 
book (.book) files created to identify the correct form when keying from images. 
Click Select… to open the Select Autograph Signature File dialog box, select an 
autograph file, and click OK. 

** An autograph book is a collection of format signatures that identifies and opens 
the appropriate application based on the first batch image for the user to start a 
new batch for keying. (The .book file also identifies the format that best fits the first 
batch image.) Typically, you will associate two or more applications to each 
autograph book. See Appendix 2, Signatures, for detailed Signatures feature 
information. 

The Assign application drop-down list allows you to select a previously assigned 
application to a batch. Or, to select a different application, click this drop-down list 
and choose Select… to open the Assign Application dialog box, left click an 
application and choose Select to return to the Waybill Entry dialog box with the 
new application selected. 

Delete Note: You can highlight an application and press the Delete key to remove 
an application from the list. 
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The Batch name drop-down list allows supervisors to name batches with a naming 
(replaceable characters) restriction. You can view names already assigned to 
batches to duplicate the established naming convention. 

The Instructions to operator field allows you to type messages that appear within 
the Waiting for Work dialog box when this specific waybill is dispatched to 
operators. 

Create Task Actions 

If you have the Imaging Add-on module, you can specify these image-related actions. 

Pre-record OCR for entry–you pre-recorded OCR data to be played back during 
data entry. You must also select the correct autograph book from the Form 
Identification drop-down list.  

Signature and Autograph Book Note: You must have created a format signature 
file (.sig) to pre-record OCR data while mounting image files. Then, to automatically 
recognize the associated application based on the first image, you must also have 
created an autograph book (.book) file. See Appendix 2, Signatures, for detailed 
information about creating format signatures, autograph books and pre-recording 
OCR. 

Import images to a batch–use this if you need to import and OCR images before 
you create a batch. If no OCR or validation errors occur, the batch moves to a 
Verify task. If you encounter KFI fields or errors, the batch moves to an Update 
task. Use the DM ERR command to find screens flagged in error. In both cases, 
the Create waybill state is skipped. 

Expedite (Pre-record and/or Import)–separates OCR data that requires operator 
intervention from error-free, low-doubt-level OCR data. Depending upon the format 
design, good data can go directly from the source directory to a batch that is 
flagged as ready for extraction. This method is intended for use even with unrelated 
forms. (Dependencies between batch pages are not supported since images may 
be placed in either normal edit or extended edit checks in order to pass OCR 
checks.)  

Assign images for KFI–you will assign images to the batch. KFI licensing is 
required at the workstation, along with OCR if images are connected with signature 
analysis. 

(Assign images) for OCR–you will assign images to the batch. Both KFI and OCR 
licensing is required at the workstation. 

Note: Though supervisors must pre-assign images if creating a single waybill, this isn’t 
necessary if creating two or more waybills using the waybill generator function because 
Falcon32 does this automatically based on the Live directory settings on the Import 
tab. 

You can also specify the following create actions: 
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Specify starting application–starts a batch using the application specified in the 
Assign application drop-down list. If the application has a naming (replaceable 
characters) restriction, you must name the batch in the Batch name field.  

Note: The Create a Batch option in the Waybill tab allows you to select 
applications that either auto-name batches or require you to manually name your 
batches. If you select either of the Waybill generator options, you will only be 
allowed to select applications that auto name batches. 

Display Easy Key–once the operator logs on, the Easy Key dialog box displays, 
with all options disabled except 1-Create a Batch to prevent the user from working 
on batches outside the workflow. (This option is available for non-imaging only.) 

Select the Operator allowed to assign images check box to allow the operator to 
perform an additional imaging add-on function: assign image files to the batch after 
the initial image list is exhausted. Since this isn’t allowed under normal managed 
workflow circumstances the default for this option is not selected.
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Verify Tab 

The Verify tab controls how an operator verifies a batch. 

 

Key verify the batch–allows Falcon32 to assign the verify task. Use the Assignments tab 
to assign the verify task to one or more verify operators. 

Notify user or group–notifies one or more supervisors that a batch is ready for verification. 
(These users are specified in the Assignments tab, Warnings drop-down list.)  

If this option is selected, the operator needs to use Falcon32 to manually verify the batch or 
a supervisor needs to manually promote the waybill job to the verify stage by right-clicking 
the waybill in the Workflow Management Console dialog box and selecting the Clear 
Exception State and Run option. Then, operators can initiate verification options manually 
or through the Waiting for Work dialog box. 

Not yet implemented Manual Verification Note: If the operator manually verifies a batch 
that is part of a waybill, it automatically proceeds to the extract stage once verified and 
saved. 
 
Skip Verification–does not verify data but marks the batch as verified once all records are 
initially keyed into the batch and saved. 
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Extract Tab 

The Extract tab allows you to automate and customize batch extraction. Otherwise, the 
operator needs to use Falcon32 to manually perform batch extraction. 

 

Extract Task Options 

Auto-extract–automatically performs extraction. 

Notify user or group–notify one or more supervisors that a batch is ready for 
extraction. (These users are specified in the Assignments tab, Warning drop-
down list.)  

If this option is selected, the supervisor needs to use Falcon32 to manually 
promote the waybill job to extract by right-clicking the waybill in the Workflow 
Management Console dialog box and selecting the Clear Exception State and 
Run option. Then, operators can initiate extraction options manually or 
automatically using a logon password allowing automated work. See Appendix 1, 
Robot ID to learn how to setup permissions for automated work. 

Not yet implemented Manual Extraction Note: If the operator manually 
extracts a batch that is part of a waybill, it automatically proceeds to the Archive 
waybill stage. 
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Skip–omits the extraction stage. 

Extract Type 

The following options automatically extract the batch using built-in Falcon32 methods or by 
using an extra-cost utility. 

Untranslated–extract individual untranslated data (appropriate format for 
mainframe). 

To XML–XML data. 

ASCII with decimal points–extract individual ASCII with decimal points. 

ASCII without decimal points–extract individual ASCII without decimal points. 

Not yet implemented Command line–This field is only enabled if 
FLCNEXTR.32.exe exists in the Falcon32 installation directory. Select New… or 
Change… to create or update a new set of options for extracting the batch using 
Falcon Extractor. 

The Extract target directory drop-down list specifies the storage location of the 
extract file. Click Browse… to select directory.  

• If left blank, extracts are stored in the Falcon32 extract directory 
(Falcon32\EXT).  

• If you select a target directory and do not select the External Only check box, 
extracts are stored in both the Falcon32 extract directory and the specified 
target directory. 

• If you select a target directory and select the External Only check box, 
extracts are only stored in the specified target directory. 
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Archive Tab 

The Archive tab allows you to automate and customize data archiving and removal from 
the workflow. Otherwise, the operator uses Falcon32 to manually perform archiving. 

 

Archival Action 

Auto-archive extract–automatically archives the batch extract and enables all 
archival options. If this option is not selected, the supervisor needs to use Falcon32 
to manually archive the batch extract and additional files. 

Supervisors can promote this waybill to the archive stage by opening the Waybill 
Job Status Console, selecting the waybill file and choosing the Change Waybill 
Status option from the Action menu.) 

Notify user or group–notifies one or more supervisors that a batch is ready for 
archiving. (These operators are specified in the Assignments tab, Warning drop-
down list.  

If this option is selected, the supervisor needs to use Falcon32 to manually 
promote the waybill job to the archive stage by right-clicking the waybill in the 
Workflow Management Console dialog box and selecting the Clear Exception to 
run option. Then, operators can perform archive options manually or automatically 
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using a ROBOT logon password. See Appendix 1, Robot ID to learn how to setup 
permissions for automated work. 

Manual Extraction Note: If the operator manually archives a batch that is part of a 
waybill, it automatically proceeds to the Finished waybill stage. 

Skip–will not auto archive the batch extract and relevant files. 

Batch File 

Do nothing–leaves the batch in the batch directory 

Delete file–deletes batch. 

Archive file–used in tandem with the Archive Files Target Directory options, 
moves the batch to either (or both) the Waybill and specified location in the 
Archive Files Target Directory drop-down list. 

Change batch status to PROD–changes the batch status to PROD, which assists 
in manually rerunning batch extraction. This option does not affect other selected 
options. 

Sidecar Files 

Sidecar files contain image data for a file with the same name in the same folder except 
with a different extension; this includes .ilk, .fsd, .fmi, .fmi.ocr files. 

Do nothing–leaves the sidecar files in the batch directory. This is the default option 
if the Imaging Add-on module is installed. 

Delete file–deletes the sidecar file. 

Archive file–moves the sidecar file to Falcon32’s Waybill directory. This is the 
default option if there is no Imaging Add-on module. 

Copy/Moved Image or Text Files 

These options apply if you selected either the Move to work directory or Copy to 
work directory from the Import tab. 

Do nothing–if you selected Move to work directory or Copy to work directory 
from the Image tab, this option keeps the source image file(s) that was moved or 
copied into Falcon32’s Waybill directory. 

Delete file–if you selected Move to work directory or Copy to work directory from 
the Image tab, this option deletes the source image file(s) that was moved or 
copied into Falcon32’s Waybill directory. 

Archive file– if you selected Move to work directory or Copy to work directory 
from the Image tab, this option keeps the source image file(s) that was moved or 
copied into Falcon32’s Waybill directory. 
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Archive Files Target Directory 

The Archive Files Target Directory drop-down list specifies the storage location 
of the archive file. Click Browse… to select a directory. 

• If left blank, files are archived in the Falcon32 Waybill directory 
(Falcon32\Waybill). 

• If you select a target directory and do not select the External Only check box, 
files are archived in both the Falcon32 waybill directory and the specified target 
directory. 

• If you select a target directory and select the External Only check box, files 
are only archived in the specified target directory. 



  Waybill Entry Fields 

Tutorial 49 

 

Assignments Tab 

The Assignments tab allows you to delegate each segment of work. If it doesn’t matter 
who performs the task, select the #ANYOPER (any operator) default group ID option. You 
can create up to 15 group IDs (including the built-in #ANYOPER ID). See Chapter 2, 
About Task Groups section, to learn how to create task groups and assign users. 

The Author(s) drop-down list displays all Falcon32 user IDs creating using the Define User 
ID option from the Option >Security Properties menu. 

 

The Create drop-down list allows the selected person or group to create a batch.  

Note: Importing images or text, pre-recording, and starting an expedited batch is 
handled by the person or group listed in the Automate drop-down list. Assigning images for 
KFI is done immediately after you click Release on the Waybill Entry dialog box. 

The Update drop-down list allows the selected person or group to make edits to an existing 
batch. If an operator suspends a batch during create, entry or update mode, or doesn’t 
finish keying all the images the batch, the waybill remains in the Update state. 

The Verify drop-down list allows the selected person or group to verify a batch. The 
supervisor can select the Notify user or group option, located in the Verify tab, to 
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suspend this state until the supervisor clears this verify notification by right-clicking the 
waybill in the Workflow Management Console dialog box and selecting the Clear 
Exception to run option. Then, operators can initiate verification options manually or 
through the Waiting for Work dialog box. 

The Extract drop-down list allows the selected person or group to run an automated 
extraction process. (Make sure you select the person or group who can receive the 
notification that a batch is ready for extraction.) 

The Archive drop-down list allows the selected person or group to run an automated 
archive process. (Make sure you select the person or group who can receive the notification 
that a batch is ready for archiving.) 

The Warnings drop-down list allows the selected person or group to be notified if a waybill 
is suspended because something unexpected occurred. Examples are: (Warnings)-access 
denied (no valid user ID to assign a task), failed extraction; (Notifications)-ready for verify, 
extract, or archive. See the Wait to warn (hours) topic below for an additional warning 
exception. 

The Automate drop-down list allows you to indicate access to the selected person or group 
to log on to Falcon32 using a ROBOT (automated user ID) and open the Waiting for Work 
dialog box. This initiates automated processes without operator intervention. Eligible 
operators can disable accepting automated tasks by selecting the Do not accept 
automated tasks check box in the Waiting for Work dialog box. 

Note: If all waybills were set at the standard default priority of 5, the highest priority tasks 
are: expedited waybills, create (i.e., importing images or text, pre-recording), update and 
verify tasks. If no waybills for these tasks exist, waybills needing to Start, Qverify, Extract, 
and Archive dispatch. 
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Waybill Tab 

The Waybill tab allows you to create and customize single or multiple waybills. 

 

Select the Create a Batch option to create a single waybill for a batch. 

Select the Waybill generator: Paper workflow option to create two or more waybills at the 
same time for multiple key-from-paper batches. This option only allows you to select 
applications that auto-name the batch. If you need to manually name (replaceable 
characters) your batches, you must create each waybill individually. Also, all Imaging Add-
on options disable if you use this option. 

Use the Count option to select the number of waybills to create at the same time. 

Select the Waybill generator: Use new files in the “live” directory option to create a 
waybill from files in the live directory, specified via the Import tab. (“Live” applies to 
directories that do not contain a fixed number of files because they are usually receiving new 
files.) In addition, complete the Count need for new waybill field to configure the size of 
each batch and the Delay before generating… option. 

• Select the Count needed for new waybill option to specify the number of images 
(or in rare cases, text files) to incorporate into each batch. If your images are stored 
as one image per file, choose a number consistent with your data entry work. 
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Usually, an average of 25 images is assigned to each batch. If your images are 
stored as multiple images per file, you would typically select 1. 

• Select the Delay before generating partial waybill (minutes) option to set the 
number of minutes to wait to create a waybill when insufficient files exist to create a full 
batch. After the time expires, Falcon32 will create a partial batch. The default is 0. 

Not yet implemented Select the Use the document mask to determine count needed for 
new waybill option to sort a group of image or text files into groups using the document 
mask specified in the Import tab. 

Select the Treat “live” directory as read-only mounted media (CD, DVD) option to 
create batches using all the files in the live directory, specified via the Import tab. When 
this option is selected, Falcon32 ignores the Delay before generating partial waybill 
(minutes) setting and creates partial batches. 

Select the Waybill is finished when all files in the “live” directory are processed so the 
waybill will process all the files in the live directory, specified via the Import tab, create a 
final partial batch if needed, and then change the waybill status in the Workflow 
Management Console dialog box to Finished.  

Note: If this Waybill is finished when all files in the “live” directory are processed 
option is not selected, Falcon32 periodically checks the indicated “live” directory for new 
files AND it will not change the waybill status to Finished in the Workflow Management 
Console dialog box. (The waybill generator’s status will also never change to Finished.) To 
generate a final partial batch and get a final indicator that all files are processed, type a 
number in the Delay before generating partial waybill (minutes) field. 

Select the Archive live files to: option to specify a path that copies the files automatically 
from the source directory into an archive directory. This feature is useful if the source 
directory files are original files that are not backed up, as in the case of a source directory 
being an FTP destination directory.  

Import Tab 

The Select Files button opens an Open dialog box for you to import either a text file or an 
image file but not both types at the same time.  
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The Document Mask drop-down list contains a list of previously selected masks. Or, you 
can create a document mask to sort a group of image or text files. To do this, create a 
document mask that inserts G or L characters where the document name changes (e.g., 
day of the month) to sort files in ascending G (greater than) or descending L (less than) 
alphanumeric order. When specifying a mask, start with the rightmost character (counting 
the period and extension). For example, to create a document mask for YYYYMMDD date 
where DD identifies a different document, you could use any of the following document 
masks.  

YYYYMMDD.ext 

 200704GG.tif 

 yymmGG.jpg 

 GG.jpg 

 GGxxxx 

G (greater than) indicates the sort character in the current file name is greater than the sort 
character in the previous document in the list. 

L (less than) indicates the character in the current file name is less than that of the previous 
document in the list.  
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The Count field is the number of files selected in the File and Directory list. 

The File and Directory list displays files associated with this batch.  

Directory Notes:  

For the next three options, the source directory must be available to the workstation 
processing the Start task, using the same directory path, in order to use the files. For the 
Use in place option, the source directory must be available to all operators, using the same 
directory path, in order to use the files. 

The Move to work directory option moves selected files from the source directory to that 
waybill’s subdirectory of the Falcon32 Waybill directory. The subdirectory name given is the 
name of the waybill being created. 

The Copy to work directory option copies selected files from the source directory to that 
waybill’s subdirectory of the Falcon32 Waybill directory. The subdirectory name given is the 
name of the waybill being created. 

The Use in place option uses the selected files from the source directory.  

Select the Hide file after selecting check box to assign the DOS hidden file attribute to 
files to indicate they were already selected and will not appear (or will be grayed out) in 
Windows Explorer or any Windows Open dialog when you click the Select Files button. 
This protects against selecting the same files. If this attribute is selected, a file will not be 
hidden if the waybill is cancelled before it is released, you decide to cancel and select other 
files, or if you perform the Delete Waybill and Restore Imports action. 

Note: The Hide file after selecting option is only available if you select either the 
Copy to work directory or Use in place options. 

The Live directory drop-down list allows you to select a previously selected directory to 
automatically load files into the workflow. (“Live” applies to directories that do not contain a 
fixed number of files because they are usually receiving new files.) Select Browse… from 
this drop-down list to locate the appropriate directory. 

The File Name drop-down list allows you to select a previous wildcard specification from 
the list. If you need to select a different file name, type the file name but omit the file 
extension, typing either an asterisk or question marks as a wildcard, in order to select 
multiple files (e.g., 2007_04_* or 2007_04_??). 

The Extension drop-down list allows you to select an extension that is combined with the 
file selected in the File Name and Live directory (location) drop-down lists.  

Not yet implemented If you need to select a different extension, select New… to open the 
Create Custom Type List dialog box and select an extension type from the supported file 
types listed. 
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Operator 

Waiting for Work Fields 

The following information defines each Waiting for Work field. See Chapter 3, Operator 
Functions, to learn the operator functions for this dialog box. 

 

Figure 12 Waiting for Work dialog box.
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The Way bill ID field displays the waybill file name. 

 
The Instructions to Operator field can include supervisor instructions for a specific waybill. 
 
The Time Left field counts down the time a dispatched job is available for the operator to 
accept before it is routed to the next available operator.  
 
The Task type field indicates which stage of work the job is in: create, update, verify, 
extract, or archive. It can also display Auto (automated). Auto means the task will 
automatically run after the time expires to accept a task, eliminating the need for operator 
intervention. 
 
The Task type field indicates the type of or stage of work the job is in: create, update, 
verify, extract, archive, or Auto (automated). Auto means the task will run after the time 
expires to accept a task, eliminating the need for operator intervention. 
 
The Batch field indicates the batch name. 
 
The Application field indicates the application name assigned to the batch. 
 
The Expedite work check box is activated when the user first selects this option and then 
accepts a job. Once this job is complete and the user saves it, the Accept and Reject 
options disable so the operator can receive the next and subsequent jobs immediately. To 
enable the Accept and Reject options again, cancel the current job.  
 
The Do not run automated tasks check box prevents the Waiting for Work dialog box 
from running automated tasks that your logon password may be eligible to run. 
 
The Always use the Waiting for Work dialog check box automatically displays the 
Waiting for Work dialog box each time a user logs on and redisplays after each new job.  
 
The Accept button picks up the dispatched job. The Counts field to the right lists the 
number of jobs accepted since logging on.  
 
The Reject button rejects the dispatched job. (The same job does not appear immediately 
unless there are no other jobs.)  The Counts field to the right lists the number of jobs 
rejected since logging on. 
 
The Break Time button should be used after your current job is completed. Once activated, 
it defers all incoming jobs. (Though the currently dispatched job will automatically reject 
once you click Break Time, it will not count as a rejected job and can be dispatched to you 
again.) The Counts field to the right displays the cumulative break time since logging on. 
 
The Close button returns you to the Falcon32 main menu. (The Close button displays 
instead of the Logoff button if a user manually opens the Waiting for Work dialog box 
using Ctrl+E or selecting Batch>Waiting for Work… from the Falcon32 main menu.  
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The Logoff  button logs you off from Falcon32. 
 
The Exit button closes the Waiting for Work dialog box and returns to the Falcon32 main 
menu. (The Close button displays instead of the Logoff button if a user manually opens the 
Waiting for Work dialog box using Ctrl+E or selecting Batch>Waiting for Work… from the 
Falcon32 main menu. 
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Appendix 1 
Robot ID 

Add Robot ID to User Profiles (Logon Passwords) 

The following procedures show how to create a unique logon password (ROBOT) for 
automated waybill tasks. Automated waybill tasks include: setting up imaging batches 
(when importing and mounting images), running the waybill generator, quick verifying 
batches, extracting batches, and archiving files. 

To add automated waybill permissions for an existing user, see the Add Automated 
Waybill Permissions to Existing User procedure later in this appendix. 

To create a unique logon password for automated waybill tasks:  

1. Log onto Falcon32 as a Control User. To do this, type one of the predefined Logon IDs 
in the Logon ID field (OPER1, OPER2, OPER3) and then type either POWER in the 
Password field or leave the Password field blank. 

2. Click Logon to launch the Falcon32 application. 

3. From the Falcon32 main menu, select Option >Security Properties... 
The Security Properties dialog box opens. 
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4. Click Define User Profiles (Logon Passwords). 
The User Profile List dialog box opens. 

 

5. Type ROBOT in the blank field and click Properties. 
The ROBOT Properties dialog box opens, displaying the Permissions tab. 

 

6. To create a password only for automated tasks that run immediately upon logon, select 
the Upload, Extract and Delete options from the Permissions tab, Batches column. 



 Add Automated Waybill Permissions to Existing User 

 Tutorial 

Warning: Make sure the Data Entry option in the Batch column is not selected 
because it causes a 30 second delay between automated batches AND sends the user 
entry and verify work. 

 

7. Click OK to return to the User Profile List dialog box. 

 

8. Click Add and then click OK to save. 

Add Automated Waybill Permissions to Existing User 

 Add permissions to existing users needing to log on and initiate tasks pre-specified as 
"automated" in a waybill assignment. 

Automated waybill tasks include importing and mounting images, extracting batches, and 
archiving files and do not require a dedicated operator. 

To add automated waybill permissions to an existing user profile (logon password): 

1. Log onto Falcon32 as a Control User. To do this, type one of the predefined Logon IDs 
in the Logon ID field (OPER1, OPER2, OPER3) and then type either POWER in the 
Password field or leave the Password field blank. 
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2. Click Logon to launch the Falcon32 application. 

3. From the Falcon32 main menu, select Option >Security Properties….  
The Security Properties dialog box opens. 

 

4. Click Define User Profiles (Logon Passwords).  
The User Profile List dialog box opens. 

 

5. Select the existing user logon profile (this changes the Add button to a Modify button) 
and click Properties. 
The user logon Properties dialog box opens, displaying the Permissions tab. 
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6. To create a password for data entry, verify work, and automated tasks (up to 30 second 
delay between batches), select the Data Entry, Upload, Extract and Delete options 
from the Permissions tab, Batches column. 

Note: To create a password only for automated tasks that run immediately upon logon, 
select the Upload, Extract and Delete options from the Permissions tab, Batches 
column AND clear the Data Entry check box. Since this password is used for data 
entry operators using the Launchpad dialog box, use the Add Robot ID to User 
Profiles (Logon Passwords) topic to create a dedicated automated task password. 
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7. (Optional) To automatically open the Waiting for Work dialog box upon logon, select 
the Data Entry Helper is Waiting for Work check box in the Attributes tab. 

 

8. Click OK to return to the Security Properties dialog box. 

 

9. Click OK to save. 
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Appendix 2 
Signatures 

Overview 

Format signatures are a method by which Falcon32 can analyze the form depicted in an 
image and determine the format to be used to key or OCR the data in the image. 

Signature analysis allows you to define a rectangular area, like a paper stencil. You apply 
that stencil to each image. If for example, you read "FORM-A" in the rectangle, you know it 
is FORM-A. This is the signature for FORM-A. 

Now assume you have three forms. You cut out two more holes in the stencil. When you lay 
it on an image of FORM-A, one rectangle reveals "FORM-A" and the others “highlight” 
nonsensical wording but if you were to look at this stencil on an image of FORM-B, Form-
B’s rectangle would “highlight” "FORM-B." This “stencil” is called a format signature in 
Falcon32. 

Falcon32 allows you to create two types of signature files, autograph books (.books) and 
format signature files (.sig). Both contain format signatures that operate as described above 
but they serve different purposes. 

In an autograph book, each format signature also has the name of a Falcon32 application 
associated with it. So, when Falcon32 identifies FORM-A, it now knows that PAYABLE is 
the application required (along with format FORMA). Falcon32 can then either pre-record 
OCR data or start a batch. Falcon32 then uses the format it recognizes (in this case format 
FORMA used to key/OCR the FORM-A form), as the first format in the batch. Falcon32’s 
autograph book only recognizes the first image in an image file and to assigns the 
application and the first format. 

Falcon32 uses format signature files to determine the next format to assign to the next 
image in the image file. This works like format chaining, but it selects the next format not 
based on format order (sometimes called level order), but by examining the next image. 
When you start a batch using an application, Falcon32 searches for a format signature file 
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with the same name as the application, and if located, automatically uses it. Since Falcon32 
uses format signatures to determine the next format, format signatures generally work on 
the second and subsequent images in the image file. If you pre-record OCR or start a batch 
with an autograph book, programmatically assigning an application, for example, 
PAYABLE, Falcon32 uses the format signature file that corresponds to the assigned 
application, in this case, PAYABLE.SIG, for the second and subsequent images. 

Autograph books can be used to pre-record OCR when the application is not known ahead 
of time by using the Mount Image Directory dialog box and the Select Image Files to Mount 
dialog box. You can also use autograph books to start a batch using the Easy Key dialog 
box: use function 5 (Create Image Batch) to specify the image file, press Enter, and then 
select an autograph book. 

Format signature files can also be used to pre-record OCR, but by providing the name of 
the format signature file, you also specify the application of the same name. (Note that 
when pre-recording OCR using a format signature file, Falcon32 performs signature 
analysis on the first image in the image file using the format signature file to determine the 
first format.) As stated earlier, if a format signature file exists for the application assigned to 
a batch, Falcon32 automatically uses it. However, if a chain format is specified for a format 
in the batch or a format uses the FORMAT extended edit, Falcon32 will use the chain 
format name or FORMAT extended edit provided name and skip signature analysis. 
Signature analysis resumes on the next image, if possible. 
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Create a Format Signature File 

When keying from images, the Signature function allows you to create signature zones that 
tell Falcon32 where to look for text, marked fields (OMR), or barcode information on forms 
used to identify the form. 

To perform signature analysis, complete the following for each sample form image: load 
each image, draw a signature zone around a static item, assign a recognition method, test 
the recognition method’s readability (optional), and save.  

Chain and Extended Edit Note: If a chain format is specified for a format or a format uses 
the FORMAT extended edit, Falcon32 uses the chain format name or FORMAT extended 
edit provided name and skips signature analysis. Signature analysis resumes on the next 
image, if possible. 

Warning: You must first create a format and assign a sample image to the format. 

To create one or more format signatures and zone tests: 

1. Open an application. 

2. On the Imaging menu, click Signatures… 
The Format Signature Builder dialog box opens. 

3. Click Zones. 
The Signature Zone Maintenance dialog box opens. 

4. Select a format from the Format (sample Image) list. Falcon32 displays only the 
formats for the application you opened which also have sample images. 
The form image displays in the Image Pane area, located on the right side of the 
dialog box. The image toolbar becomes active. 

5. Use the mouse to draw a signature zone around a static item on the form that can 
uniquely identify it. 
The Signature Zone Details dialog box opens. 

6. Type a recognizable zone name for that particular format in the Name (required) 
field. You can use up to 20 characters with spaces. 

7. Click OK. 
The new zone displays in the Zones list. 

8. (Optional) To test if the zone you defined captures the desired content, select the 
zone in the Zones list and click Test. To request the system view the zone contents 
differently, select the: 

� Case sensitive check box to show the text without converting the zone 
content to all uppercase; the zone content displays in the Test Data box as it 
appears on the form. Selecting or clearing the check box automatically 
initiates the different view.  

� Ignore Spaces check box to show the zone content without spaces. 
Selecting or clearing the check box automatically initiates the different view. 
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Note: These settings are not remembered. If text doesn’t accurately display, you may 
need to reposition or resize the zone. 

9. Click Save. 
The Format Signature Builder dialog box displays. 
Note: If no “test suites” are assigned, the Insert Test Suite dialog box opens to insert 
at least one test. Perform the following bulleted items to create a “test suite,” one or 
more tests the system performs while trying to identify, match, and process the correct 
formats and form images. 
To insert subsequent tests, you must click Insert to open the Insert Test Suite dialog 
box and perform the following bulleted items. 

� Type a recognizable test name (i.e., CMSformlabel) in the Name field, select 
the correct zone from the Zone list, and then click Insert. 
The new test opens in the Test Suite dialog box, with the cursor positioned in 
the Format to test for signature list. 

� From the Format to test for signature list, select the format that will be used 
if the format signature matches. By default, Falcon32 displays the first format 
in the application automatically. 

� Click Insert to create a single test of the signature zone. 
The Insert Signature Test dialog box opens. 

� Click Fill from Zone to populate the Data area and then delete any content 
you do not want matched. So long as the data is unique in the zone on this 
form and on other forms that might be tested, the smaller the data the better 
to minimize recognition errors. For example, in "ATTENDING DENTIST'S 
STATEMENT DELTA 105 REV. 7189", "105 REV. 7189" would be sufficient 
and probably unique. 

� Keep the Ignore Spaces check box selected to give the system the best 
chance of recognizing the data by eliminating judgement as to the spacing 
between letters. 

� Click Insert to save the Data area’s zone test content. 

� Click Close to exit the Insert Signature Test dialog box. 
The Test Suite dialog box displays with the accepted test in the Tests list, 
with a list of columns that specify the test attributes.  
Note: Because recognition software sometimes identifies "0" as "O" and "1" as 
"l", etc., you may need to add additional tests. 

� Click Save. 
The Insert Test Suite dialog box redisplays. 

� Click Close. 
The Format Signature Builder dialog box redisplays. 

10. Click Save. 
The application list of formats redisplays. 

11. Click Close on the File menu to close the application and return to the Falcon32 main 
menu. 
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Modify an Existing Zone Test for a Format Signature 

You can modify an existing zone test for a format signature by: 

• editing the test content. 

• changing how the test is processed (i.e., the order, recognize some or the entire 
content). 

To modify an existing zone test: 

1. Open an application. 

2. On the Imaging menu, click Signatures… 
The Format Signature Builder dialog box opens. 

3. Select a zone test name (Name column) for the signature zone name (Zone column) 
to modify. 

4. Click Modify. 
The Test Suite dialog box opens, displaying the selected zone test. 

5. Click Modify. 
The Modify Signature Test dialog box opens, displaying the zone content the system 
uses for matching a format signature. 

6. Modify one or more of the following test search parameters for a format signature 
using the Action list: 

� No Match: test passes if the zone content does not match the test data. 

� Immediate Match: test passes if some or all of the zone content matches the test 
data. 

� Group Match: test passes only if some or all of the zone content, for all Group 
Match tests, matches the test data. 

� Must be this: test passes if the zone content matches the test data exactly. 

� Default: Test passes regardless of zone content and marks batch with an OCR 
error code. 

� Match All: Test passes regardless of zone content except it does not mark the 
batch with an OCR error code. 

Qualifiers area: 

� Case sensitive check box specifies that the system should not convert zone 
content to all uppercase before running a comparison; zone test content is 
checked as it appears on the form, whether mixed case or all uppercase. This is 
useful when the only distinction between two forms may be a case difference. 

� Ignore Spaces check box specifies that the system should remove spaces in the 
zone contents before running a comparison. 

Data area: 

� Delete or add any content. 
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7. Click Modify. 
The Test Suite dialog box displays. 

8. Click Save. 
The Format Signature Builder dialog box redisplays. 

9. Click Save. 
The application redisplays. 

10. Click Close on the File menu to close the application and return to the Falcon32 main 
menu. 

Delete an Existing Zone Test for a Format Signature 

You can delete a zone test for a format signature. 

To delete a zone test: 

1. Open an application. 

2. On the Imaging menu, click Signatures… 
The Format Signature Builder dialog box opens. 

3. Select the name (Name column) of the test suite you wish to delete for a particular 
signature zone (Zone column). 

4. Click Delete. 
The test suite is removed from the list.  
Note: If you want to also delete the zone associated with the test suite, delete the zone 
in the Signature Zone Maintenance dialog box after you delete all its tests suites. To 
cancel delete actions, click Cancel. 

5. Click Save. 
The application redisplays. 

6. Click Close on the File menu to close the application and return to the Falcon32 main menu. 
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Change Zone Test Order for Format Signatures 

The Up and Down buttons change the order a signature test is run. 

To change the order: 

1. Open an application. 

2. On the Imaging menu, click Signatures… 
The Format Signature Builder dialog box opens. 

3. Select a test. 

4. Click Up to move the zone test toward the top of the list, causing it to run before the 
tests below it. 

5. Click Down to move the zone test toward the bottom of the list, causing it to run after 
the tests above it. 

6. Click Save. 
The application redisplays. 

7. Click Close on the File menu to close the application and return to the Falcon32 main 
menu. 

Open an Autograph Book 

You can open existing autograph book (.book) files. 

To open a .book file: 

1. Select Imaging > Open Autograph Book from the main menu. 
The Open Autograph Book dialog box opens up to the format (.fmt) directory where 
all .book files are stored. 

2. Select a .book file and click Open. 
The Autograph Signature Builder dialog box opens. 

Create a New Autograph Book 

You can create an autograph book (.book) file, a collection of format signatures that 
identifies the application that could be assigned a batch for keying; the .book file also 
identifies the first format in a batch. Typically, you will associate two or more applications to 
each autograph book. (You can access a .book file to create a batch using the Easy Key 
dialog box.) 

Pre-recording OCR Note: A .book file is required in order to pre-record OCR data while 
mounting file images. Pre-recording OCR allows you to run OCR on one workstation to play 
back on another machine. This saves the data entry operator for having to wait while OCR 
is done before the next image is presented. In this scenario, an OCR license is not required 
on the playback machine. 
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Before you begin, you must assign form images to all formats in all applications you will 
assign to the autograph book. Additionally, you should also have a list of formats that 
correspond to the first image in the image files you will be using for data entry. (It is the first 
image in the image file that Falcon32 uses to determine which application to assign.) 

To create a .book file: 

1. Select Imaging > New Autograph Book from the main menu. 
The Signature Zone Maintenance dialog box opens. 

2. Select a format from the Format (sample image) list that will be assigned to the 
application you will include in the autograph book.  
The Image Pane displays the sample image for the format. The image toolbar 
becomes active. 
Note: If your input image files will always have a header image, select the format 
representing that, otherwise you will need to add all the formats for the application by 
repeating these steps. 

3. Use the mouse to draw a signature zone around static text that can uniquely identify 
the form. 
The Signature Zone Details dialog box opens. 

4. Type a recognizable zone name for that particular format in the Name (required) 
field. You can use up to 20 characters with spaces. 

5. Click OK 
The new zone displays in the Zones list of the Signature Zone Maintenance dialog box. 

6. (Optional) To test if the zone you defined captures the desired content, select the 
zone in the Zones list and click Test. To request the system view the zone contents 
differently, select the: 

� Case sensitive check box to show the text without converting the zone content to 
all uppercase; the zone content displays in the Test Data box as it appears on the 
form. Selecting or clearing the check box automatically initiates the different view. 

� Ignore Spaces check box to show the zone content without spaces. Selecting or 
clearing the check box automatically initiates the different view. 

Note: These settings are not remembered. If text doesn’t accurately display, you may need 
to reposition or resize the zone. 

7. Repeat steps 2-6 for all the formats in all the applications you want to support.  
Note: It is allowed if two forms have a form ID in the same place; ensure each 
signature zone is sized and positioned so the zones do not overlap but still fit within the 
form image. You will later test the zone twice, looking for the ID.  

8. Click Save. 
The Insert Test Suite dialog box displays. (This automatic, since you have defined no 
test suites yet. In the future, you will need to click the Insert button on the Autograph 
Builder dialog box first.)



Create a New Autograph Book 

Tutorial 

 

9. In the Name field, type a recognizable zone test name (up to 20 characters including 
spaces). 

10. Select the signature zone name from the Zone list. 

11. Click Insert. 
The new test for the zone opens the Test Suite dialog box, with the cursor positioned 
in the Application combo box. 

12. Select the correct application for this format from the Application list. 
The Format to test for signature combo box populates with a format. If there are 
multiple formats in the application, choose the format you want to test from the list. 

13. Click Insert. 
The Insert Signature Test dialog box opens. 

14. You can change the zone test in the following manner: 

� The Action list allows you to specify how to perform a test for a format signature. 

� The Qualifiers check boxes allow a user to alter how the system will compare the 
signature zone to the test data: Case Sensitive (will not convert the zone 
contents to uppercase during a search because the only distinction between 
forms may be a case difference), Ignore Spaces (default, performs a search 
without recognizing spaces in the zone content) and Fuzzy (not applicable at this 
time).  
Note: The default options (Ignore Spaces is selected and Case Sensitive is not 
selected) perform the most reliable test.  

� The Zones button opens the Signature Zone Maintenance dialog box, allowing 
the user to insert, modify, or delete signature zones. 

� Clicking the Fill From Zone option performs character recognition on the 
signature zone text and displays in the Data field. Modify test data in the Data 
field to alter what is tested.  

15. Click Insert. 

16. Click Close to exit the Insert Signature Test dialog box and return to the Test Suite 
dialog box. 
The Test Suite dialog box displays the accepted test in the Tests area with a list of 
columns, specifying the test attributes. 

17. To add further tests using the same signature zone specified in step 10, click the 
Insert button and repeat steps 12-16. 

18. Click Save to exit the Test Suite dialog box. 
The Insert Test Suite dialog box redisplays 

19. To create tests that use other signature zones, repeat steps 9-18. 

20. Click Close to exit the Insert Test Suite dialog box. 

21. Click Save to save updates and close the Autograph Signature Builder dialog box. 
The Save Autograph Book dialog box displays showing the contents of the Falcon32 
format directory.  
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Warning: Since all signature files are stored in this location, do not save in another 
location.  

22. Type an autograph book name in the File name field. 

23. Click Save. 

Pre-record OCR While Mounting Image Files 

You can pre-record any recognition method (OCR, IMR, OMR, barcodes), including 
OMRGRP edits, while mounting individual image files. Pre-recording OCR allows you to run 
OCR on one workstation to play back on another machine. This allows entry operators to 
avoid a pause between pages when Falcon32 recognizes text on the next image. This is 
also a way of associating a number of image files into one that contains all the images 
necessary for a batch. In this scenario, an OCR license is not required on the playback 
machine. 

Warning: You must create a format signature file (.sig) to pre-record OCR data while 
mounting image files. To automatically recognize the associated application based on the 
first image, you must also create an autograph book (.book) file. 

To use OCR while mounting file images: 

1. On the Imaging menu, click Mount Images. 
The Mount Image Directory dialog box opens. 

2. Click Select Files. 
The Select Image Files to Mount dialog box opens to the .dat directory. 

3. Select the Pre-record OCR check to run character recognition while mounting the 
image files you select. 
The Detect and Select signature file areas display at the bottom of the dialog box. 
Note: The output file will have an .FMI.OCR extension. 

4. Falcon32 can automatically determine the application to assign to the batch, or you 
can implicitly assign one. Do one of the following: 

� Select the Application and its formats option to select an application signature 
file (.book) from the Select Signature File list. Falcon32 will use this file and the 
first image to select the application to assign the batch and to select the first 
format needed for the image. Falcon32 will then proceed to use the format 
signature file (.sig) associated with the programmatically selected application. 

� Select the Formats for a specific application option to select a format signature 
file (.sig), associated with the application you want to open, from the Select 
Signature File list. This assigns the associated application to the batch. Formats 
are assigned to each image using the format signatures in the format signature 
file. 

5. After selecting either a .book or .sig file from the Select signature file list, select any 
number of files in the file directory shown. If necessary, you can navigate to another 
directory to pick files.
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Note: To select nonadjacent files, click one file, and then hold down the Ctrl key and 
click each additional file. To select adjacent files, click the first file in the sequence, and 
then hold down the Shift key and click the last file. 

6. Click Open. 
The Mount Image Directory dialog box is revealed, displaying the list of selected 
images, the location of the source image file, and the destination directory. 

7. Click Mount to copy files to the Mount directory. 
Falcon32 generates a report within seconds. 

8. Click Cancel to exit the Mount Image Directory dialog box and read the output 
report. 

9. (Optional) Print the output report by selecting Print… from the File menu and once 
the Print dialog box opens, click OK. 

10. (Optional) Select Save from the File menu. 
The Save As dialog box opens. 

11. Type a filename and click Save. 
The .rtf file saves in the default .dat folder location. 

12. Select Close from the File menu to close the output report and return to the Falcon32 
main menu. 

Merge Individual Image Files to One Multi-page Image File 

You can merge individual image files into one multi-page image file. If the images are not 
compressed, this will compress the images and aid performance at the entry workstation. 
Merging can be an effective method of creating image files which correspond to a single 
batch, aiding the data entry operator. Merged images are created in a directory containing 
only merged files. 

To merge individual file images into one large multi-page image file: 

1. On the Imaging menu, click Mount Images. 
The Mount Image Directory dialog box opens. 

2. Click Select Files. 
The Select Image Files to Mount dialog box opens to the .dat directory. 

3. Select two or more image files. 

Note: To select nonadjacent files, click one file, and then hold down the Ctrl key and 
click each additional file. To select adjacent files, click the first file in the sequence, and 
then hold down the Shift key and click the last file.  

4. Select the Merge to one file option to attach all selected file images into one output file. 
Note: This action creates a new file with the following naming convention: the name of 
the first and last file and in parentheses, the number of images. 
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5. Click Open. 
The Mount Image Directory dialog box is revealed, displaying the list of selected 
images, the location of the source image file, and the destination directory. 

6. Click Mount to copy files to the Mount directory. 
Falcon32 generates a report within seconds. 

7. Click Cancel to exit the Mount Image Directory dialog box and read the output 
report. 

8. (Optional) Select Save from the File menu. 
The Save As dialog box opens. 

9. Type a filename and click Save. 
The .rtf file saves in the default .fmt folder location. 

10. Select Close from the File menu to close the output report and return to the Falcon32 
main menu. 

Signature Zone Maintenance Dialog Box 

The Signature Zone Maintenance dialog box allows you to create signature zones that tell 
Falcon32 where to look for text, marked fields (OMR), or barcode information on forms that 
can be used to identify the form. To perform signature analysis, perform the following for 
each sample form image: load each image, draw a signature zone around a static item, 
assign a recognition method, test the recognition method’s readability (optional), and save. 

Chain and Extended Edit Note: If a chain format is specified for a format or a format uses 
the FORMAT extended edit, Falcon32 uses the chain format name or FORMAT extended 
edit provided name and skips signature analysis. Signature analysis resumes on the next 
image, if possible. 

Warning: You must first create a format and assign a sample image to the format. 
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The Zones list contains the following column data for the signature zone you create for 
each form image: 

� Name displays the signature zone name. 

� Zone displays the numeric location of the signature zone in the image pane. The 
number can change and is not significant except to help you map the name to 
the signature zone on the image. 

� Type identifies the recognition method used to read information from the image. 
It can read OCR, OMR, BAR, or 2D (2-dimensional barcode). OMR, BAR and 2d 
is not yet implemented. 

� Coordinates shows the signature location relative the upper left corner of the image. 
The upper left cornerof the zone is shown in parentheses and its dimensions follow. 

� DPI displays the dots per inch resolution of the form image that corresponds to the 
signature zone. 300 DPI is recommended, though a range is allowed. If all samples do 
not share the same DPI, inaccuracies in the workflow may result. 

Add Details displays a dialog box allowing you to change the recognition method, location, 
and size of a specific zone. Not implemented. 

Delete removes the selected signature zone from the Zones window. 
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The Format (sample image) list contains a list of formats containing at least one form 
image. Select from the list to display the corresponding sample image and draw or modify 
the corresponding signature zone. Select other images to ensure the zone doesn't contain 
matching information from another form. 

Autograph Signatures: All formats that are available (that contain at least one assigned 
form image) display in this list. 

Format Signatures: Displays formats already attached to the active (open) application. 

The Test button allows you to run recognition on the signature zone selected from the Zone 
list. View the test results in the Test Data window to determine whether the zone is 
positioned correctly. 

Note: If you want to test the results of a different image, select the image from the Zones 
list. 

The Test Data window records the results of clicking the character recognition Test button. 

The Case sensitive check box modifies the recognition data to not convert data to all 
uppercase. Selecting or clearing the check box automatically initiates another test. 

The Ignore Spaces check box modifies the character recognition test to not include 
spaces. Selecting or clearing the check box automatically initiates another test. 

The Image Pane displays the form image that is selected from the Format (sample image) 
list and a toolbar that contains character recognition and image size functions. All 
previously defined signature zones display – regardless of what image they were drawn on. 
This allows you to ensure that a zone intended to recognize one form doesn't accidentally 
contain the same data on a different form. All images in a data entry project share the same 
character recognition space and cannot overlap. You can resize these signature zones. 
Because images vary in size, predefined signature zones from other images may not 
appear because they are partially or completely outside the image area displayed. If this is 
the case, they will be ignored for signature analysis. 

The Font (machine-generated)  icon recognizes text generated by typesetting, laser 
printing, fax, and dot matrix printers at Letter Quality or Near Letter Quality. 

The Barcode  icon specifies the image contains from 1-10 one-dimensional barcodes. 
The output is numeric. (Falcon32 does not recognize text inside barcode zones; this text 
slows the character recognition rate.) 

Supported barcodes are: CODE 39 (Code 3 of 9), CODABAR, ITF (2 of 5 interleaved), 
CODE 128, UCC Code 128, Code 2 of 5, Code 93, UPC-A, UPC-E, EAN-13, and Postnet. 

The 2D Barcode  icon specifies the image contains a single PDF 417 barcode. These 
barcodes can produce up to 2000 characters. Due to record size limitations, Falcon32 
accepts up to 1024 characters.
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The Check box  icon specifies a non-text zone and recognition determines if the check 
box is selected or cleared. 

The Numbers Only  icon indicates to recognition that the field contains only numbers; 
this improves character recognition accuracy. 

The Show/Hide Image Preview  icon displays a full preview of the image in the Image 
Pane. Move the blue square around the image preview, using a mouse, and the image in 
the Image Pane moves to that area. 

The Fit Horizontal  icon fits the image to the current Image Pane width. 

The Fit Vertical  icon fits the image to the current Image Pane height. 

The Fit in Window  icon fits the image to the current Image Pane dimensions. 

The Zoom 25%  icon allows you to view the image at 25% of its original size. 

The Zoom 50% icon allows you to view the image at 50% of its original size. 

The Zoom 75%  icon allows you to view the image at 75% of its original size. 

The Zoom 100%  icon allows you to view the image at 100% of its original size. 

Save retains all signature zone changes. 

Close discards signature zone changes. 

Help opens online Help. 
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Signature Zone Details Dialog Box 

 
 

The Name (required) field allows you to name the newly defined zone. 

OK saves the name. 

Cancel closes the dialog box. 

Help opens online Help. 
 

Insert Test Suites Dialog Box 

This dialog box displays when inserting a signature test. 

 
Specify a unique zone test name (up to 20 characters) in the Name field. 

Select the signature zone name from the Zone list. 

If applicable, the Message area displays status messages. 

Click Insert to accept the zone name, insert this test, and display the Test Suite dialog box 
to define individual tests to determine which format corresponds to the tested image. 

Click Zones to open the Signature Zone Maintenance dialog box and insert, modify, or 
delete signature zones. 

Cancel closes the dialog box. 

Help opens online Help.
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Test Suite Dialog Box 

The Test Suite dialog box allows you to insert a test, set and test the recognition method, 
determine the test run order, and delete a test. 

Autograph books only: It also allows you to assign an application to a batch once the tests 
in the Test Suite dialog box pass. 

 
The Test list contains the following column data for the format or application signature zone 
displayed. You can double-click an item in this column to open the Modify Signature Test 
dialog box and specify the following tests: 

� The Action column allows you to specify how Falcon32 will perform the test for a format 
signature. If you want to perform a variety of different tests, make sure the Match All or 
Default test parameters are not specified because they override all other test parameters.  

o No Match: test passes if the zone content does not match the test data. 

o Immediate Match: test passes if some or all of the zone content matches the test data. 

o Group Match: test passes only if some or all of the zone content, for all Group 
Match tests, matches the test data. 

o Must be this: test passes if the zone content matches the test data exactly. 
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o Default: Test passes regardless of zone content and marks the batch with an OCR 
error code. 

o Match All: Test passes regardless of zone content except it does not mark the batch 
with an OCR error code. 

� The Case Sensitive column indicates whether Falcon32 converts the zone contents to 
uppercase before the test data searches for matching zone content. 

� The Ignore Spaces column indicates whether spaces are ignored (Yes) or read in the zone 
content (No) when the test data searches for matching zone content. 

� The Fuzzy column identifies this item is an alternate, possible match. Not yet implemented. 

� The Data column specifies the test data used to compare against zone content. 
(Autograph books only) The Application list displays autograph book (.book) files. If the 
tests in this Test Suite dialog box pass, Falcon32 assigns the selected .book file to the 
batch. 

Select a format from the Format to test for signature list. 

Reminders: 

Format signatures: This list displays available formats only for the application being edited. 

Autograph book: This list only displays formats for the application you select from the 
Application list. 

Up moves the signature test toward the top of the list, causing the test to run before the 
tests below it. 

Down moves the signature test toward the bottom of the list, causing the test to run after 
the tests above it. 

Delete removes the signature test. (To cancel a delete action, click Cancel.) 

The Insert button opens the Insert Signature Test dialog box and places a new test before 
or after the highlighted selection in the Test list, depending upon the Insert option (Before 
or After) selected. 

Modify opens the Modify Signature Test dialog box, allowing you to alter the selected 
test. 

Use the Insert options Before and After in conjunction with the Insert button option to 
place a new test before or after the signature highlighted in the Tests list. 

Save allows you to save all changes. 

Cancel ignores all changes and closes the dialog box. 

Help opens online Help.
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Insert/Modify Signature Test Dialog Box 

The Insert/Modify Signature Test dialog box, allows you specify/alter test data in a 
signature zone. 

 
 

 
The Test Number indicates the order in which the test will be performed in the test suite. 

The Action combo box allows you to specify how to perform a test for a format signature. 
Tests are always in the order listed below. Because certain tests prevent initiating other 
tests, only valid tests display in the combo box For example, Immediate Match always 
precedes Group Match and if you select the Default or Match All option, you cannot insert 
any other type of test. 
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• No Match: test passes if the zone content does not match the test data. 

• Immediate Match: test passes if some or all of the zone content matches the test 
data. 

• Group Match: test passes only if some or all of the zone content, for all Group 
Match tests, matches the test data. 

• Must be this: test passes if the zone content matches the test data exactly. 

• Default: If selected, this is the only allowable test in the test suite. Test passes 
regardless of zone content and marks batch with an OCR error code. 

• Match All: If selected, this is the only allowable test in the test suite. Test passes 
regardless of zone content except it does not mark batch with an OCR error code. 

 
Select the Case Sensitive check box to specify that Falcon32 convert the zone contents to 
uppercase before the test data searches for matching zone content. 

Select the Ignore Spaces check box to specify that Falcon32 ignore spaces in the zone 
content when the test data searches for matching zone content. 

Select the Fuzzy check box to perform alternate possible matches. Since recognition 
returns more than one result for each character position, Falcon32 compares and lists 
alternate possible matches for questionable characters. Not yet implemented. 

The Data window allows the user to specify or alter the signature text. 

The Fill from Zone option fills the Data window with the zone contents on the format 
sample image. Use this option to more accurately uncover inconsistencies in recognized 
text based on font. 

The Zones option opens the Signature Zone Maintenance dialog box, allowing the user to 
insert, modify, or delete signature zones. 

(Modify only) Previous and Next displays the previous and next test from the Test window. 

(Modify only) Modify allows you to save all changes. 

(Insert only) Insert allows you to insert a signature test. 

Close cancels actions and closes the dialog box. 

Help opens online Help. 
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Format/Autograph Signature Builder Dialog Box 

The Format Signature Builder dialog box and the Autograph Signature Builder dialog 
box are very similar dialog boxes, but modify different files. 

Format Signature Builder: allows you to update existing format signature (.sig) files for an 
application. 

Autograph Signature Builder: allows you to update format signatures stored in a standalone 
autograph book (.book) file. 

 



Appendix 2 
Signatures 

Tutorial 86 

 
 

The Test Suite window contains the following column data for the displayed format 
signature zones in a format. 

• The Name column displays the test suite name. 
Note: In addition to clicking Modify, you can double-click a row in the Name column to 
open the Test Suites dialog box. 

• Format Signature Builder: The Member column displays the format name. 

• Autograph Signature Builder: The Member column displays the format name, and (in 
parentheses) the name of the application. 

• The Zone column displays the zone name the system uses to check the format 
signature. 

• The Actions column displays the number of test suites (tests) defined to identify a 
format. 

• If the Match All column is Yes, it identifies that a test will pass, regardless of zone 
content, except it does not mark the batch with an OCR error code. If selected, this is 
the only allowable test. 

• If the Default column is Yes, it identifies that a test will pass, regardless of zone 
content, except it marks the batch with an OCR error code. If selected, this is the only 
allowable test. 

Up moves the signature test toward the top of the list, causing it to run before the tests 
below it.
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Down moves the signature test toward the bottom of the list, causing it to run after the tests 
above it. 

Delete removes the signature test. (To cancel a delete action, click Cancel to discard all 
changes.) 

The Insert button opens the Insert Signature Test dialog box and places a new test before 
or after the highlighted selection in the Test window, depending upon the Insert option 
(Before or After) selected. 

Modify opens the Modify Signature Test dialog box, allowing you to modify the selected 
zone test. 

Zones opens the Signature Zone Maintenance dialog box and inserts, modifies, or 
deletes signature zones. 

Use the Insert options Before and After in conjunction with the Insert button option to 
place a new test before or after the signature highlighted in the Test Suites list. 

Save saves the change and closes the dialog box. 

Cancel cancels an action and closes the dialog box. 

Help opens online Help. 
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